
WinGIF Index

The Index contains a list of all Help topics available for WinGIF.    Index items are arranged 
either alphabetically within each major category or by menu order.    You can use the scroll 
bar to see the entries that are not currently visible in the Help window.

For information on how to use Help, press F1 or choose Using Help from the Help menu.
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How to View an Image

WinGIF can be used to view files in GIF, PCX, BMP, and RLE formats.    To view an 
image file in any of these formats, choose the File Open command, highlight the image file 
name and select Open.    WinGIF will then display the image.

If the image contains more colors than your Windows driver is able to display, the 
image will not look correct when you first open the file.    To get the best possible view of 
such images from your Windows driver, use WinGIF's ability to dither the image by using 
either the Edit VGA 16 Dither or the Edit Monochrome Dither commands.



GIF or PCX to BMP Conversion

To create a BMP file suitable for use as Windows wallpaper from an existing image in 
GIF or PCX format, first load the GIF or PCX file using the File Open command.

After WinGIF finishes opening your file, you might notice that the colors don't look 
right, we'll fix that later; for now, resize the image to the desired size using one of the 
Resizing commands in the Edit menu.    Several of the most common screen sizes have their 
own menu items, but if you want to specify an exact size, you may do so using the Edit 
ReSize command at the bottom of the edit menu.

Now that your image is the correct size, it is time to correct the colors.    The most 
common reason colors are not correct is because the source image had more colors than 
your windows display can show.    WinGIF solves this problem by dithering your image.    You 
may choose one of two dithering commands in the edit menu: the Edit VGA 16 Dither 
command or the Edit Monochrome Dither command.    If you have a color EGA/VGA display, 
choose the former; otherwise, choose the latter.

The next step is to use the commands in the Edit Palette submenu to fine-tune the 
image and then choose the Edit Palette Accept Palette command to accept the colors.

Finally, you are ready to save your image as a BMP file.    Use the File Save command 
and choose BMP as the file type.    Save the file in your windows directory if you want control 
panel to show your BMP file as one of the choices for wallpaper.



How to Interrupt Processing in WinGIF

To interrupt WinGIF while it is processing during a File Open or a dithering 
command, you can either press the ESCAPE key or double-click on the system menu and 
answer no to the message that asks you if you want to quit WinGIF.



Selecting a Region

You may select a portion of an image by positioning the mouse cursor on the top-left or 
bottom-right corner of the region desired and then pressing the left mouse button and 
dragging the mouse to the opposite corner.    You can also directly select a region by entering
its position directly into the Edit Clip dialog box.
Selecting a region is necessary before using the Edit Trim command and is optional before 
the Edit Clip and the Edit Copy commands.



File Menu

The File menu includes commands that enable you to open and save files, and to print.

Open...
Save...
Printer Setup...
Print
Exit



Edit Menu

The edit menu in WinGIF provides commands for manipulating and editing the currently 
loaded graphic image.    It also provides tools for copying and pasting to the clipboard

Resize X 2
Resize X 3
Resize to VGA
Resize to 800 X 600
Resize to 1024 X 768
Resize X 1/2
Resize X 1/3
VGA 16 Dither
Monochrome Dither
Mirror
Flip
Rotate
Palette
Paste
Copy
Trim
Clip...
ReSize...



Options Menu

The options menu in WinGIF provides access to WinGIF options which affect may affect how 
other commands operate.    All of the commands in the options menu except for Full Screen
toggle on and off as you select them.    When options are changed their new setting is saved 
in the wingif.ini initialization file.

Full Screen
Resize to Scale
Clean Background
Decode to Screen
Alt Dither Palette
Shadow Dither
Memory Image
Memory DIBs Only
Auto Minimize
Full page Print
LTE Gray Display



Keyboard Shortcuts

The following keys may be used within WinGIF:

F1 Help
Shift F1 Help Mode
F2 Full Screen
Shift F2 Show Image in Full Window (hide menu and title bar)
Alt F2 Show Image in Full Window and use the full palette
F3 Clip
F4 ReSize
F5 Accept Palette
F7 Brightness -
F8 Brightness +
F9 Contrast -
F10 Contrast +
ALT F7 thru ALT F10 Same as F7 thru F10 but in larger increments

Cursor Keys Scroll the Image.



Help

The help menu in WinGIF provides access to the Windows Help program and to an About 
box which gives information about the program and how to register your copy of WinGIF.



Glossary

BMP
bpp
brightness
clipboard
contrast
dib
dither
GIF
palette
PCX
RLE
scale



Opening Files

Choosing the File Open menu command brings up the open dialog box.    Choose an image 
file encoded in BMP, RLE, GIF, or PCX format, then click the OK button to open the file.    This
command is affected by the following option menu options:    Clean Background, Decode to 
Screen, Auto Minimize.    Also see How to Interrupt Processing.



Saving Files

Choosing the File Save menu command brings up the save dialog box.    Choose an image 
file name and then click on the Format button to choose between the RLE 4, RLE 8, BMP, 
PCX or GIF format, then click the OK button to save the file.

When you have chosen a format, the other options in the save dialog box are enabled or 
disabled as appropriate for your format.    The options labeled 1, 4, 8 and 24 bpp determine 
the number of colors available for you picture.    The option Interlace GIF, available only if 
the GIF format, saves the image in interlace mode.



The File Printer Setup Command

This command brings up the printer setup dialog box.    This dialog box differs with each 
printer driver you may be running.    Changes made with this command will affect only 
WinGIF and not other applications.



Printing Files

Choosing the File Print command will begin printing the currently loaded image according 
to the options set with the File Printer Setup Command and the Options Full Page Print 
Command.



Exiting WinGIF

Choosing the File Exit command or double-clicking on the System Menu will exit WinGIF.    
You will not be prompted for a confirmation unless WinGIF is currently processing a 
command.



Resizing the Image

The following commands may be used to resize an image after it has been loaded:

Edit Resize X 2 Doubles the size of the image
Edit Resize X 3 Triples the size of the image
Edit Resize to VGA Resizes to the standard VGA resolution (640 X 400)
Edit Resize to 800X600 Resizes to the standard SVGA resolution 800X600
Edit Resize to 1024X768 Resizes to the standard SVGA resolution 1024X768
Edit Resize X 1/2 Resizes to 1/2 original size
Edit Resize X 1/3 Resizes to 1/3 original size
Edit ReSize... Resizes to any specified resolution and contains options for 
performing dithering at the same time and for preserving the original image's scale.



Dithering the Image

Two commands are available to dither an image after it has been loaded.    These two 
commands are as follows:

Edit VGA 16 Dither Change the image to use a standard EGA/VGA 16 color palette.
Edit Monochrome Dither Change the    image to use only black and white.

These commands are affected by the Clean Background, Decode to Screen, Alt Dither 
Palette, Shadow Dither, and Auto Minimize options.

These two dithering options are also available from the Edit ReSize... dialog.



Mirroring the Image

The Edit Mirror command produces a mirror image (left-right swapped) of the currently 
loaded image.    Choosing Edit Mirror a second time reverses the action.



Flipping the Image

The Edit Flip command flips the currently loaded image so that the top and bottom portions
are swapped.    Choosing Edit Flip a second time reverses the action.



Rotating the Image

The Edit Rotate command rotates the current image clockwise 90 degrees.    Choosing Edit
Rotate three more times reverses the action.



Palette Manipulation

The Edit Palette menu item brings up the submenu below.    These commands allow you to 
alter the current image's palette.    The cumulative results of any of these commands except 
Accept Palette are reversible using the command Restore Palette

256 Grays
64 Grays
16 Grays
8 Grays
4 Grays
Contrast +
Contrast -
Brightness +
Brightness -
Accept Palette
Restore Palette



Pasting from the Clipboard

The Edit Paste Command loads any image in the    Windows clipboard into WinGIF.    The 
clipboard image must be encoded in Windows bitmap or DIB format.



Copying to the Clipboard

The Edit Copy command copies the current image into the Windows clipboard.    WinGIF 
exports the Windows bitmap and DIB formats to the Windows clipboard.

If you Select a Region before choosing Edit Copy, only the selected region will be copied to 
the clipboard.



Trimming the Image

To trim an image, first Select the Region that you would like to keep and then choose the 
Edit Trim command.    Trimming may also be done without a mouse from within the Edit Clip
command.



Clipping the Image

You may provide precise coordinates for trimming or clipboard copies by using the Edit Clip 
command.    This command prompts you for an X and Y Origin.    This origin is the top-left 
corner of the region to be kept.    It also asks for the X and Y Dimensions which are the 
width and height, respectively, of the region.

Pressing OK returns you to the image and shows you where your region is.    You may then 
choose Edit Clip again to modify your region or to press Trim which will trim your image 
using the region.

If you Select a Region with the mouse before choosing Edit Clip, the selected region will 
automatically be entered in the X and Y Origin and Dimension fields.



The ReSize Dialog

The ReSize dialog is invoked using the Edit ReSize... command.    This dialog lets you resize
your image to any resolution, maintain the original scale, apply an new scaling factor, or 
perform dithering and resizing at the same time.

The Width and Height fields let you specify the size of the image exactly.    If you have the 
Resize to Scale option checked then whenever you change the Width or Height and press
TAB, the other dimension (Height or Width) is updated automatically to preserve the original 
image's scale.

Entering a number in the Scale Factor field and pressing TAB automatically changes the 
values in the Width and Height fields by the scale you enter (i.e. entering 2 in the Scale 
Factor field will double the width and height values).

The No Dither, VGA Dither, and B/W Dither options determine which, if any, dithering 
should be performed at the same time as the resizing.    VGA Dither corresponds to the Edit 
VGA 16 Dither command and the B/W Dither corresponds to the Edit Monochrome Dither 
command.    Stretching and dithering in one step will significantly reduce the memory 
requirements from those for stretching and dithering separately.

Pressing OK performs the resizing (and dithering, if selected).



Full Screen Option

The Options Full Screen command shows your image on a full screen, using all available 
colors in the color palette.    Normally windows reserves 20 colors from SVGA displays for 
system use.    In this mode this feature of windows is disabled to give a full 256 colors.    To 
return to the normal Windows display, press any key.



Resize to Scale Option

The Options Resize to Scale command toggles the Resize to Scale option.    This option 
affects the commands Resize to VGA, Resize to 800X600, and Resize to 1024X768.

When this option is turned on, the scale of the original image is preserved when the 
commands above are chosen.    The resulting image is the largest scaled image which can fit 
inside the specified dimensions.

By their nature, the Resize X 2, Resize X 3, Resize X 1/2 and Resize X 1/3 always preserve 
scale whether this option is on or not.



Clean Background Option

The Options Clean Background command toggles the Clean Background option.    When 
this option is on, the screen will be erased before showing a new or modified image with the 
File Open, VGA 16 Dither, or Monochrome Dither command.



Decode to Screen Option

The Options Decode to Screen command toggles the Decode to Screen option.    When 
this option is on, the WinGIF window will show its progress during the File Open, Edit VGA 16 
Dither, and Edit Monochrome Dither commands.

When this option is off, you will not see the results of the commands above until WinGIF is 
finished processing the entire image.



Alt Dither Option

The Options Alt Dither command toggles the Alternate Dither option.    When this option is 
on, WinGIF will use an alternate dithering palette during the Edit VGA 16 Dither.

It is best to experiment to see whether the default dithering algorithm or the alternate 
dithering algorithm yield the best results for an image.



Shadow Dither Option

The Options Shadow Dither command toggles the Shadow Dither option.    When this 
option is on, WinGIF will attempt to darken the dark areas of an image during the Edit VGA 
16 Dither and Edit Monochrome Dither commands.

It is best to experiment to see whether the Shadow Dither option yields the best results for 
an image but generally this option is recommended.    Similar and also more dramatic results
can be achieved by enhancing contrast and adjusting brightness before dithering. 



Memory Image Option

The Options Memory Image command toggles the Memory Image option.    Most users will
want to keep this option on.    This option should be turned off only when available memory 
in your system is very low, or when you are running in Windows real mode.



Memory DIBs Only Option

The Options Memory DIBs Only command toggles the Memory DIBs Only option.    This 
option should be turned on when available memory is getting low.    Screen update times will 
be slower with this option on.



Auto Minimize Option

The Options Auto Minimize command toggles the Auto Minimize option.    When this 
option is on, WinGIF will automatically make itself into an icon at the bottom of the screen 
whenever opening a GIF file or dithering an image.



Full Page Print Option

The Options Full Page Print command toggles the Full Page Print option.    When this 
option is on, WinGIF will tell windows to size images while printing to fill the page as well as 
possible while still maintaining the original image's scale.



LTE Gray Display Option

The Options LTE Gray Display command toggles the LTE Gray Display option.    When this 
option is on, WinGIF will choose colors that result in a grayscale display on a Compaq LTE 
386/20.

This command can also be used with some success on other systems; the result being an 
abstract and sometimes pleasing posterization of your image.



Changing the Palette to Grayscale

Five commands under the Edit Palette submenu allow you to change your palette from 
color to grayscale.    These commands are the 4, 8, 16, 64, and 256 Grays commands.

Note that a grayscale display is not the same as a monochrome display.    If you have a 
monochrome display (one that can display only black or white) you should use the 
Monochrome Dither command.



Changing the Image Contrast

You may use the Contrast - and Contrast + commands from the Edit Palette submenu to 
increase or decrease the contrast in your image.



Changing the Image Brightness

You may use the Brightness - and Brightness + commands from the Edit Palette 
submenu to increase or decrease the brightness of your image.



The Edit Palette Accept-Palette Command

When you select this command, WinGIF first sorts the colors in the palette in order of 
descending use in the image, then frees any palette entries that are not used in the image.   
This can make the palette smaller and it can also eliminate problems with pictures that use 
all the colors that Windows can display.    (Windows normally reserves 20 colors from a 256 
color display.    Sorting gives accurate color for the most used colors.)    If you load an image 
with WinGIF on a 256 color display and notice some areas of the picture do not look correct 
then using this command may solve the problem.

It is a good idea to always choose this command right before saving an image since the 
palette associated with the image might be made smaller.

This command is not reversible with the Restore Palette command.



The Edit Palette Restore-Palette Command

This command changes the image palette to either the original palette or the last one 
accepted with the Accept Palette command.

This allows you to make changes with the commands in the Edit Palette submenu and later 
be able to restore the original palette.



BMP

BMP is a native Microsoft Windows format.    To use an image as wallpaper, you must use 
either this format or RLE.



BPP

This acronym stands for Bits Per Pixel.    The number of colors available to your image is 
determined by this number.    If the image is stored with 1 bpp, then only 2 colors are 
available; 2 bpp yields 4 colors, 4 bpp yields 16 colors, 8 bpp yields 256 colors, 24 bpp yields
over 16 million colors.    However, the higher the bits per pixel, the more memory is required 
to store the image.



Brightness

Changing the brightness of an image causes all of the colors in the palette to either increase
in brightness or decrease in brightness by the same amount



Clipboard

The windows clipboard allows cutting and pasting of images from WinGIF to other 
applications.



Contrast

Changing the contrast of an image cause the light colors to be lighter and the dark colors to 
be darker so that the difference between the light and dark colors is greater



DIB

DIB (Device Independent Bitmap) is an graphics format used internally by some Microsoft 
Windows programs.



Dither

Dithering an image reduces the number of colors that it uses.    It does this by approximating
colors using dithered patterns.    For example, a block of 4 orange pixels might be 
approximated with a top row of Red-Yellow and a bottom row of Yellow-Red.    In this way the 
orange part of the picture is approximated in a palette that is too small to hold the orange 
color, but already has red and yellow.



GIF

The GIF (Graphics Interchange Format) is defined by CompuServe, Inc.    It is a compressed 
image format and is a popular format for on-line image storage.



Palette

An image's palette is the set of colors available for use in the image.



PCX

The PCX image is a popular graphics file format defined by ZSoft, Inc.



RLE

The RLE (Run Length Encoded) format is really just a variation of the BMP format.    It is used 
by Microsoft Windows programs.    This format may be used as Windows wallpaper, but to do 
so, it must be saved with a .BMP extension.



Scale

Scale refers to the proportion of height to width.    If the scale of an image of a circle is not 
preserved after resizing, the circle may end up looking like an ellipse.



Interlace Mode

Interlace mode is a GIF file option which causes the image lines to be stored out of order 
starting every eighth line.    It is especially useful for on-line storage of images because you 
can get an idea of what an image looks like early in the download process.


